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Quick Start Guides 
Easy Steps 
  

Contents 

• 1 The Easy Steps component  
• 2 Easy Processes  

o 2.1 Buy/Pay 
o 2.2 Sell 
o 2.3 Bank 
o 2.4 Report 
o 2.5 Set Up 
o 2.6 VAT 
o 2.7 Tax/Year End 

The Easy Steps component 

 

 
Central to the V3 edition of our software is the Easy Steps feature. It is situated 
on the left of the main tool bar at the top of the application. 
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If you don't have the Easy Steps icon showing, then it means you are using an 
earlier version of the software. If this is the case there is an upgrade available 
for all existing users. Please contact Accountz or visit our online shop for pricing 
details. 

Easy Steps takes most of the normal tasks you do on a day to day basis and 
simplifies them into a number of simple steps. If you are not sure what to do, 
then click on the Easy Steps icon and follow the instructions. 

When you click on Easy Steps a new panel will open with a number of options 
across the top. Click on each section header (e.g. 'Buy/Pay') to see the options 
within that section. 

Clicking on a tile launches a step by step wizard process to walk you through the 
selected task. The final screen of each Easy Steps process details the options 
selected thus far. 

The final step for each process is the Finish button. Click this to complete the 
process. 

Easy Processes 

The Easy Steps feature covers the following processes (click on the header, e.g. 
'Sell' to reveal the options within each section): 

Buy/Pay 

• Help me decide 
• Add an Expense 
• Buy Equipment 
• Buy Company Vehicle 
• Buy Stock for Resale 
• Buy Other Asset 
• Buy Goods from EC Zone 
• Buy Service from EC Zone 
• Add New Supplier 
• Delete Supplier 
• Send a Purchase Order 
• Convert Purchase from Order 
• Refund a Purchase 
• Add an Expense Account 

Sell 

• Sell Something on Credit 
• Send an Invoice 
• Sell Something for Cash/Cheque/Card 
• Add a New Customer 
• Delete Customer 
• Send a Quotation 
• Convert a Quote to Sale 
• Refund a Sale 
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• Send a Credit Note 
• Add a Sales Account 

Bank 

• Setup Direct Debit/Standing Order 
• Record Bank/Finance Charges 
• Top Up Petty Cash 
• Part Pay / Pay Credit Card Balance 
• Transfer to Another Bank 
• Record Drawings 
• Record PAYE and Payroll 

Report 

• Profit and Loss 
• Balance Sheet 
• Trial Balance 
• Creditors 
• Debtors 
• Uncleared Transactions 
• Display current VAT Return 

Set Up 

• Setup New Company 
• Opening Balances 
• Add a Bank Account 
• Add an Expense Account 
• Add a Sales Account 
• Templates Builder 
• Add a new Product 
• Local Backup Settings 
• Cloud Backup Settings 
• Restore a Backup 
• Make a Backup 

VAT 

• VAT Options 
• Complete Flat Rate Return 
• VAT Payment / Refund to HMRC 
• Display Current VAT Return 

Tax/Year End 

• Pay TAX/NIC 
• Complete Year End 
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The Accountz Philosophy 
Accountz is based on the world professional standard of double-entry 
accounting. However, Accountz differs from other professional software in the 
way double-entry is presented to you, the user. We have removed the jargon 
and transformed the process. Instead of Credit and Debit, you now have From 
and To. Here is an example of how this simple transformation turns double-entry 
from difficult to easy: 

Example: Suppose we pay business rates by direct debit from our bank. In a 
typical double-entry software system you would make 2 entries. The first would 
debit your business rates account. The second would credit the bank (yes, 
credit). Both entries would be for the same amount, hence the books would 
balance and all is well. 

 

 

Fig 1. Traditional double-entry journal 

 
The problem is, what exactly does a ‘credit’ mean when we are taking money 
from the bank? How does taking your money from your bank result in a credit 
entry? And worse, how can we remember that without taking a course in 
accountancy? 

Well, you don’t need to! Here is how this same transaction looks given the 
Accountz treatment: 

 

 

Fig 2. Accountz alternative transaction 

 
Replacing Credit with From and Debit with To simplifies everything. Having a 
single amount column guarantees the transaction balances. The point is this: 
accounting for your business means tracking the flow of money in, around and 
out of your business. 
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When you make any payment the money flows from your bank (or credit card 
etc.) to some expense or other account. This from and to concept is all you need 
to remember. It will enable you to logically understand and enter any type of 
transaction. 

When you pay off your business credit card each month from your bank, the 
money flows from  your bank to your credit card account. 

 

 

Fig 3 

 
When you make a sale, the money flows from a sales account to your bank. 

 

 

Fig 4 

 
Once you have this single rule fixed in your mind, accounting with Accountz will 
become a pleasure. 

And if you want to impress your accountant/bank manager/tax inspector, just 
remember the rule: 

• Credit = From 
• Debit = To 

 
Alphabetically they are in the same order (C before D, F before T) so it is even 
easier to remember should you need it. 

Accountz is unique amongst accounting software. It has simplified the double-
entry accounting system. Use it with confidence and it will pay dividends by 
saving you time, giving you better financial control, and therefore saving you 
money. 

 



Quick Start Guides 

7 

 
 
   

A Quick Introduction to Accounting 
  

There are only 2 reasons to account for your business: 

1. To keep Her Majesty’s Revenue and Customs happy 
2. To keep you in control of your business 

 
This overview is designed to bring the dark and mystical secrets of accountancy 
firmly into view. This will give you confidence, not only in using this software, 
but also by being able to talk to your financial advisers in their language. 
Accounting is simple. Money comes in. Money goes out. Money is what you are 
tracking. 

When you record where money came from and where it went to, you are 
recording a transaction. In Accountz, this is represented as a single row in a 
transaction table. 

 

 

 
All versions of Accountz have these three major tables: 

1. Sales Transactions 
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2. Purchase Transactions 

3. Transfer Transactions 

 
This is all you need to record every financial transaction you make in your 
business. 

Every time you sell something, you will need to enter it as a transaction in Sales 
Transactions. These can be entered directly, or via some other way such as an 
invoice. Each transaction you make affects the balance of one or more accounts 
in the Chart of Accounts. 

Every time you buy something, the same thing happens, but this time it is 
entered in Purchase Transactions. 

If you transfer some money within your business, eg topping up your till from 
the bank if you run a retail business, it is entered in Transfer Transactions. 

 
Every transaction that you enter must come from a source document. Here are a 
few common examples of source documents: 

1. An invoice you issued for a sale 

2. A petrol receipt 

3. A paying in slip from your bank 

4. A purchase order to a supplier 

5. A petty cash slip 

 
Why do you need a source document? There are 2 reasons: 

1. Without it you will never remember the date, amount and details of the 
transaction 

2. You will not be able to prove that your accounts are real and accurate to 
HMRC 

 
One golden rule of accounting therefore is to always remember to ask for a 
receipt for anything you buy. Even paying for something by debit card and 
showing the statement to HMRC is not proof that it was a genuine business 
purchase. A receipt is a must. If you are VAT registered, and you wish to claim 
the VAT back on a purchase, the receipt must also show the amount of VAT 
charged, or at least the supplier’s VAT number (on small purchases, you may 
only get a till receipt without a VAT breakdown, it is then up to you to check and 
prove how much of that receipt is VAT). 
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So, armed with a bunch of source documents, you enter them into the system, 
then what happens? This is where our software is at its best. It adds up your 
transactions for you. It sorts them into date (or any other) order. It analyses the 
accounts used so you can see how much you have in the bank. It enables you to 
see at a glance precisely how much money you are making, who owes who 
what, how much VAT is due (if you are VAT registered), and finally, it produces a 
set of reports ready for your accountant (or yourself if you are a small business) 
to sign off. 

The only thing that matters is that the software is genuinely easy to use, you 
can get at and edit all your data, you can see the results immediately, at any 
time, without having to go through the monthly rituals of traditional 
bookkeeping. Accountz does all this and more. 

 
Note to Accountants and Bookkeepers 

WARNING: This short section of the manual is full of jargon. Please skip unless 
you want to know a little more about accounting processes and the terminology. 

There is no posting or period closing in Accountz other than at year end. All data 
is live all the time. The Chart of Accounts component is a fully fledged Trial 
Balance, Profit and Loss and Balance Sheet all rolled into one. Make any 
transaction anywhere in the system and all relevant accounts are updated 
immediately. 
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The entire company history is kept, so you can view previous years’ results 
simply by changing the accounting start and end dates in the Chart of Accounts. 

Each row in a transaction table represents a complete transaction. All the 
accounts specified in that transaction including VAT Control (if relevant) are 
debited and credited immediately. Eg. create an invoice (or enter it direct into 
Sales Transactions) and the Sales account, Debtors account and VAT Control are 
updated as you type. 

Click on the VAT button and choose which period you want to see for an 
immediate and always up to date VAT return. 
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The Customer (Original, Professional, Enterprise) and Supplier Records 
(Enterprise) components are your Sales and Purchase Ledgers. Open any 
database, locate the trader, then click on the Transaction table to see just the 
transactions for that trader. It is from these ledgers that you can create invoices 
and credit notes, but with Accountz, you can also create an invoice direct from 
an entry in Sales Transactions (you can also drill down to the original source 
document direct from any transaction table). 

Accountz also includes a Journal Transactions component with access to every 
account. 

Note to ALL USERS 

Please, please read the previous Chapter (2) on making BACKUPS of your data 
(it is at the end of that chapter). 

What would you do if you lost important files on your computer due to a 
hardware failure? How much would it cost you to recover or re-input that data? 
(and that’s if you could gather it all together again). 

Making backups costs very little time and money if done regularly. 
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A Simple Guide to Bookkeeping 

Contents 

• 1 Simple Guide to Bookkeeping  
o 1.1 Introduction 
o 1.2 Transactions 
o 1.3 The Journal 
o 1.4 Posting 
o 1.5 The Ledger 
o 1.6 The Trial Balance 
o 1.7 The Profit and Loss Account 
o 1.8 The Balance Sheet  

 1.8.1 Assets 
 1.8.2 Liabilities 
 1.8.3 Equity 

Simple Guide to Bookkeeping 
Introduction 

This is a simple guide to double-entry bookkeeping, a pattern like all good 
patterns that has stood the test of time (modern double-entry was outlined in 
Benedetto Cotrugli's treatise Delia Mercatura et del Mercante Perfetto in 1458 
and expanded in Pacioli's Summa de arithmetica 36 years later). The problem 
with most guides (certainly all those I have read on the subject) is that they 
start off with the balance sheet. This is enough to put most people off for life. 

This guide takes an entirely different approach. By using a few transactions and 
some simple guidelines the logic behind double-entry becomes clear and the 
jargon falls into place. 

Words like nominal ledger and trial balance will become second nature. You will 
have no problem with your debits and credits. In short, you will be able to post a 
journal just as easily as you can now post a letter. 

By the end, you will be able to talk, and understand, the same language as your 
bank manager, accountant, and tax inspector. 

Transactions 

When we buy something there are two things to consider: 
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a) Where the money came from (i.e. the account that is paying for it, e.g. bank 
or cash) 

b) Where the money went to (i.e. what it was spent on, e.g. petrol, stationery, 
insurance) 

In a single-entry accounting system entries are recorded one after another in a 
book which typically has columns for the account used and the analysis of what 
was bought. Whilst we have no problem looking at the bank and cash columns 
as accounts, we rarely think of the analysis headings as accounts in their own 
right. 

In a double-entry system all of these are referred to as accounts (e.g. a cash 
account, a petrol account etc.), and more importantly, separate entries are 
made for each account involved in a transaction. 

Suppose we pay for some petrol with cash. Two entries are required: 

1) one to show where the money came from (cash) 

2) and the other to show where it went to (petrol). 

This from and to aspect of each transaction is known as crediting and debiting. It 
is what the term double-entry means. 

In order to record these entries we need somewhere to write them down. These 
are called Day Books or Journals. 

The Journal 

This is a book (similar to a diary) that contains various columns where day to 
day financial transactions are recorded. The minimum number of columns 
required is five: 

1) date 

2) account 

3) reference 

4) amount to debit 

5) amount to credit 

All transactions are entered one after another in date order, therefore the book 
contains a complete history of transactions in chronological order. In practice, a 
business will use more than one book, each of which will be devoted to a certain 
aspect of the business and each will be given a name to reflect this (e.g. 'sales' 
or 'purchases'). 
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Let's start with the example given earlier: purchasing petrol with cash. Two 
accounts are involved in this transaction (petrol and cash) so we will need to 
make two entries. 

The entries show how the money flows from one account to another. To achieve 
this the first entry will credit one of the accounts and the second will debit the 
other. However, deciding which account to debit and which to credit is not 
particularly obvious (getting it the wrong way round is by far the most common 
error in double-entry). 

This is where our first helpful hint comes in: 

Every transaction must come from somewhere and go to somewhere else. The 
from side is the credit side and the to side is the debit side. 

So, from=credit and to=debit. You can remember this easily because the F in 
'from' comes before the T in 'to' and C in 'credit' is before the D in 'debit'. 
Remember this single rule of wisdom and you always know your credits from 
your debits. 

Traditionally the debit column is shown to the left, and the credit column to the 
right. That is, double-entry goes to before it knows where it came from, hence 
the famous T-Shirt slogan 'Accountants do it backwards'! 

If you apply this from and to principle to our first transaction you will know 
which account to debit and which to credit: the money is coming from cash and 
going to petrol so we credit cash and debit petrol. 

Lets take a look at the cash account to understand exactly why we credit it when 
we are taking money from it. 

The cash account should be thought of as a real cash box. When you remove 
some money to buy some goods, you should replace it with a receipt or petty 
cash slip to say what the money was used for. A receipt or petty cash slip is a 
form of credit note, so the cash box now contains a credit note instead of the 
cash, hence we show the entry as a credit. (Logically, if you returned the goods 
because they were faulty, the receipt would be given back in exchange for the 
cash). 

The exact same applies to any monetary account whether it is cash or a current 
bank account. When you take money from it, it is credited in your books. 

Looking at the debit side (where the money went to), the petrol account now has 
the money (albeit in the form of half a tank of petrol!), it got the money from 
cash so it is in debt to cash - hence it is entered as a debit. 

This is the fundamental principle of double-entry, we are keeping track of where 
the money came from (a credit) and where the money went to (a debit). 

Furthermore the first rule of accounting states that all the debits must equal the 
credits. Therefore, provided all your entries are correct, no money can ever 



Quick Start Guides 

15 

escape the system or be introduced into it without a complete record of it being 
shown in the journal. 

The second example will be a sale. You will need one more account that we shall 
call Sales. In this example we will sell something for cash. Therefore the second 
set of entries will credit sales (where the money came from) and debit Cash 
(where it went to). 

As we enter more and more transactions it will become increasingly difficult to 
calculate our current cash balance (or for that matter our total sales). Therefore 
we need a way of looking at each account separately. This is achieved by making 
exact copies of the entries in the journal to another book called the ledger. This 
is called posting. 

Posting 

When posting you are not moving an entry, but making a copy of it somewhere 
else. Your original entries will always exist in the order you entered them in the 
journal. 

Posting is traditionally done at the end of each month but is entirely at your 
discretion - if you need to know what your sales figures are, then you will need 
to make sure all your transactions are entered in the journal and posted to all 
the relevant accounts in the ledger as we are about to see. 

The Ledger 

A ledger is just another book but with each page devoted to a single account. It 
is simply an alternative view of your journal entries - the journal entries are in 
date order, the ledger is a re-arrangement of the journal in account order. 

The important thing to remember is that all your transactions are entered in the 
journal first. The ledger merely contains copies of them re-arranged by account. 

Just like the journal, most businesses will use more than one ledger, each 
devoted to a certain aspect of the business and each given a different name to 
reflect this (e.g. 'Sales Ledger' and 'Purchase Ledger'), but whatever the case, a 
single general ledger will always be opened. This is called the Nominal Ledger 
(called the General Ledger in the US). 

Although it is termed 'nominal' for reasons which will become clear later, it is 
nevertheless important to realise that it is the main ledger of a business (i.e. 
where other ledgers are also in use, the final balance of those ledgers will also 
be held in the nominal ledger). Therefore, the nominal ledger will hold the full 
picture of a business however many other ledgers are used. 

In order to post (i.e. make copies of) the entries from the journal we must draw 
up a list of the accounts used so far and give each one its own page in the 
ledger. 
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We need three accounts at this stage: a cash account, a petrol account and a 
sales account. 

The layout of each account in the ledger is identical to the journal with the 
exception that the 'account' column is no longer required - we are looking at the 
entries of just one account so it can be included as the title of the page instead. 

Once we have posted our entries into the ledger we can then begin to see how 
the business is doing. 

Posted entries are exact copies of the original. If the entry was a debit entry in 
the journal then it is also a debit entry in the ledger. Although we can now see 
the relevant entries we don't yet know what the balance is; furthermore we 
don't know whether that balance means we have a surplus or a deficit of cash. 
To find out, follow this procedure: 

1. Start by adding up the debit and credit columns and show the totals on a new 
line. 

2. Subtract one from the other to get the balance using the following rules: 

a) If the debit total is greater: the balance=debits-credits and the result is put in 
the debit column. 

b) If the credit total is greater: the balance=credits-debits and the result is put 
in the credit column. 

c) In other words, we are always going to get a positive balance, and it will 
always be placed under the highest total (this is the reason the columns were 
totalled first). 

Because the balance of every account is always expressed as a positive value it 
doesn't tell us where we stand in relation to it (e.g. do we have a surplus of cash 
or is it overdrawn?). 

We can overcome this by applying our from/to guide again (from=credit and 
to=debit). If the balance is in the debit column, then we have a positive cash 
balance (more money has gone to it than from it). If it shows a credit balance 
then it is overdrawn. 

How does it apply to the sales account? If it has a credit balance, then we have 
positive sales. Where has the money come from? Sales. And finally, look at the 
petrol account. Where has the money gone to? Petrol. 

The next step is to check that all the journal entries have been posted correctly 
to the ledger. This is called a trial balance. 

The Trial Balance 
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The trial balance is a complete list of your account balances from the ledger. The 
layout is similar to the ledger except that only three columns are required: the 
account name and a debit and credit column. 

Just the final balance line of each account is copied into the trial balance using 
the debit column if the account has a debit balance, or the credit column if the 
account has a credit balance. 

The debit and credit columns are then totalled and checked that they match 
each other to satisfy the first rule of accounting (all the debits must equal the 
credits). 

If they are not equal to each other it is proof that a mistake has been made. An 
audit is then carried out to find the error. 

An audit simply means going through each entry in the journal to check that it 
matches the original paperwork (this is called an audit trail). If no error is found 
then it must be due to a mistake when posting the entries to the ledger. The 
audit then continues by checking each journal entry against the ledger entries. 

OK, so lets discover if the business is making a profit or a loss. 

The Profit and Loss Account 

The Profit and Loss account (aka P&L), as its name implies, tells us whether we 
are making a profit or a loss: are we earning more money than we are 
spending? (a profit), or vice-versa (a loss). 

The layout of the P&L account is just like any other account. To compile the P&L 
account copy the balances of the sales and expense accounts into it. We can 
then use our from/to guide on the resulting balance to determine if a profit or 
loss has been made. If more money has come from sales than has gone to 
expenses, we have made a profit. That is, if the credit side is greater than the 
debit side we have made a profit. 

Having established the P&L account we must do one more thing: take a look at 
the business as a whole. For this we need to prepare the balance sheet. 

The Balance Sheet 

We can now look at the main equation of a double-entry system which will show 
that the first rule of accounting (the debits must equal the credits) not only 
applies to each transaction but continues right up to the main financial 
statement of the business; the balance sheet. 

The P&L account reflects the balance of a specific area of your business over a 
particular period of time. The balance sheet reflects the current balance of 
everything since the business began. 

The ledger holds this information, so like the trial balance we can compile the 
balance sheet by copying all the account balances into a report. The only 
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difference is that the accounts are re-arranged to show what the business owns 
and what it owes. These are broken down into 3 groups: 

Assets 

These are the things the business owns. They are usually broken down into two 
groups: Current Assets and Fixed Assets. 

Current assets include money in the bank, petty cash, and money owed to the 
business by its customers. 

Fixed assets include capital items like business premises (assuming they are not 
rented), company cars and office equipment. 

Liabilities 

These are the things the business owes to third parties. They too are usually 
broken down into 2 groups: Current Liabilities (e.g. overdraft at the bank) and 
Fixed Liabilities (e.g. Long Term Loans). 

Equity 

Equity represents what the business owes to the owner of the business. This 
includes money paid for shares or capital introduced, any profits (or losses) 
brought forward from previous years as well as the current balance from this 
year's P&L. 

These three groups make up what is known as the accounting equation: 

Assets = Liabilities + Equity 

Easily remembered by those who like a pint with the acronym: ALE. 

Just like any mathematical equation a balance sheet can be re-arranged in any 
order you like: 

Equity = Assets - Liabilities 

Liabilities = Assets - Equity 

Probably the most useful view is Equity. Since equity is what the business owes 
its owners, it represents the value of the business from the owners point of view. 
If this were your personal accounts, it would be your net worth. 

Compiling a balance sheet is just more of what we have been doing so far; 
rearranging account balances by copying them into a different order. Assets first 
(bank balances, cash balances, debtors, unsold stock, buildings and company 
vehicles), then Liabilities (overdrafts, creditors, loans, mortgages), then Equity 
(P&L, Paid-up share capital, profit or losses brought forward from previous 
years). The Assets will have a debit balance, the liabilities (including equity) will 
have a credit balance. Add the two resulting columns up and they should both 
have the same balance. 
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Although this is a very simplified view of accounting from an initial transaction 
right through to its effect on a balance sheet, it shows just how simple the 
process really is. Before computers came along, the whole process was carried 
out manually exactly as above. Early software emulated this process, making 
things only marginally quicker by automatically adding columns. Modern 
software takes things a stage further by eliminating the need to post anything. 
All you need to enter are the original transactions. 
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Document Designer Update 
  

Contents 

• 1 Video Help 
• 2 The New Document Designer 
• 3 Running the Software Post-Update 
• 4 Using the Document Designer 
• 5 The Document Editor 
• 6 The Template Editor 
• 7 The Templates Builder 
• 8 Templates 
• 9 Locating your Documents 
• 10 Using your Old Document Designs 
• 11 Further Help 

Video Help 

For video help on the new functionality, please click here. 

The New Document Designer 

Accountz has recently released a major update to the Document Designer aspect 
of the software. 

The Designer has been upgraded and we hope that you will find it easier and 
more powerful to use. 
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Running the Software Post-Update 

 

When you run the software for the first time having installed the update, you will 
be prompted to accept a fully useable set of document templates, or create your 
own. 
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• If you are happy to use the system set of document templates, click ‘Accept 
Defaults’, and the software will insert a set of useable templates into the 
system. N.B. Should you wish to create a set of customised templates at a 
later date, the Templates Builder wizard can be run at any time by selecting it 
from the Documents main menu. 

• If you wish to set your own colour scheme, and insert your own company logo 
into your document templates, we recommend selecting the ‘Customise 
Templates’ button to run the Templates Builder wizard. This process will 
take you step by step through creating a set of customised templates. 

• If you have previously designed templates you wish to retain (e.g. Invoice 
templates), you can do so using the Convert Old Template wizard. If this 
applies to you, please click ‘Accept Defaults’ to skip the Templates Builder 
wizard, then click ' Documents>Convert Old Template' from the main menu to 
convert your existing designs. N.B. Whilst this option endeavours to convert 
existing template designs as accurately as possible, users may find that they 
need to tweak their designs further in the Template Editor screen. 

 

Using the Document Designer 

Existing users should please note that the logic within the software has changed 
slightly. 

 

 
The Documents main menu now comprises the following options: 

• Templates – the new location for all your document template designs 
• Templates Builder – this wizard enables you to create a complete (or part) 

set of customised templates 
• Reset Templates – hides all existing templates enabling the user to start 

afresh 
• Convert Old Template – enables you to convert your pre-update template 

designs 



Quick Start Guides 

23 

• Show Sales Documents – click here for all invoice and credit note 
documents 

• Show Quote Documents – click here for all quote documents 
• Show Purchase Order Documents – click here for all purchase order 

documents 

 

The Document Editor 

 

 
The Document Editor component has changed in that it is now solely used to 
create and preview documents prior to printing/export. All documents are based 
on underlying templates, the design of which can be edited in a new component, 
entitled the Template Editor. 

The Document Editor component now comprises two tabs, Data and Preview, 
which replace the View/Edit and Design/Print tabs. More information can be 
found here. 
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Users wishing to edit the look and layout of the template upon which the 
document is based can do so in the Preview tab by clicking the ‘Edit Template’ 
button in the top left of the screen, or by double clicking on the document itself. 
This launches the Template Editor component, where the user can edit the 
template that the document is based on, or create a new template, and then 
click ‘Finish Editing’ to return to the Document Editor component. 

N.B. Templates can also be edited from the Templates component 
(Documents>Templates). 

The Template Editor 

 

 
The Template Editor is where the user can edit the design of their document 
templates. Previously, such amendments were carried out in the Document 
Editor. Please see here for more information. 

This component offers enhanced functionality enabling the user to edit their 
templates more easily. 

As a new addition to the software, you can now add Custom Fields to your 
document templates, and add/remove/re-order table columns much more 
quickly. 
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The Templates Builder 

 

 
The Template Builder is a process wizard which enables the user to set global 
values (e.g. font type, table header colour) for all document templates, plus add 
a company logo to all sales/purchase type documents, and set up an invoice 
template. Please click here for more information. 

Templates 
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Every document created is based on an existing document template. All 
templates are located in the Documents>Templates component. 

Individual template designs can be edited from here by selecting the ‘Edit’ 
button, which launches the template for editing in the Template Editor 
component. 

Locating your Documents 

 

All documents (previously to be found in Documents>Documents) are located in 
the following Documents main menu options, dependent on document type: 

• Documents>Show Sales Documents - Displays all Invoices and Credit Notes 
• Documents>Show Quote Documents - Displays all Quotes 
• Documents>Show Purchase Order Documents - Displays all Purchase Orders 

 

Using your Old Document Designs 

Document designs created prior to updating can be converted for use in the new 
designer by selecting the Convert Old Template option from the Documents 
menu (Documents>Convert Old Template). 

Please note that if you revisit any old documents (e.g. invoices, purchase orders, 
etc.) created prior to updating, these will be launched in the old version of the 
Document Editor. 

Further Help 



Quick Start Guides 

27 

For more information regarding the new Document Designer, please click here. 
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Using Documents 

Introduction 

The Documents Designer component in Business Accountz has recently 
undergone a major revision. 

Therefore, you will need to discern which version of the Document Designer you 
are using. 

You can tell the version by clicking the 'Documents' main menu option in the top 
bar of the software. 

New Document Designer 

If you are using the updated version, you will see the following menu options: 

 

 
If you see this, you are using the New Document Designer, click here for more 
information. 

Old Document Designer 

If you are using the older version, you will see the following options: 
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If you see this, you are using the Old Document Designer. Please click 
Help>Check for Updates, and follow the instructions to update to the new 
Designer. 
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Accountz Cloud Backup and Recovery 

Contents 

• 1 Introduction 
• 2 Connecting to the Cloud for the first time 
• 3 Restoring from the Cloud to a second computer 
• 4 Warning Messages  

o 4.1 No Internet Connection 
o 4.2 Data Conflict 

• 5 Frequently Asked Questions 
• 6 Further Resources 

Introduction 

 

Accountz Cloud Backup and Recovery feature enables you to utilise the Cloud to 
safely and securely backup and access your accountz data. 

Please note, this is NOT a multi-user functionality, and therefore to 
avoid any potential loss of data, users are advised not to update the 
same data on different computers simultaneously. 

Connecting to the Cloud for the first time 
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Connecting to the cloud for the first time is achieved via the Cloud Backup 
Settings wizard (File>Cloud Backup Settings). This component will launch 
automatically when you licence your software. 

 

1. In the ‘Cloud Backup’ screen, click ‘Yes (setup or re-enable the service)’, and 
click ‘Next’ to continue. 
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2. At this point you will be prompted to accept the Accountz Cloud Backup 
service Terms of Use. If you are happy to do so, check the ‘I agree to the terms 
of use’ box, and click ‘Continue’. 
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3. The next screen, marked ‘Action’, details the options selected thus far. Click 
‘Finish’ to complete the wizard. 

 

 

4. Enter (and confirm) your email address; you will need to create a new 
password at this point and enter it in the password field. A record of your login 
details will be emailed to you. Click OK to complete the process. 

Your data will now be automatically backed up to the cloud every 30 minutes (by 
default), and upon closing the software. 

 

Restoring from the Cloud to a second computer 

To restore a Cloud Backup to a separate installation of Business Accountz, please 
follow these steps (please also note, you will not need to licence the new 
installation): 
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1. Select 'Restore a Backup' from the 'File' main menu. If this option is not 
available, please ensure that you are running the latest version of Business 
Accountz by clicking 'Help>Check for Updates' in the main menu. 

 

 

2. In the 'Restore a Backup' screen, select 'Choose from a list of available 
restore points (including cloud backups)'. Click 'Next' to continue. 
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3. In the 'Cloud Backup Subscriber?' screen, select 'Yes'. Click 'Next' to continue. 

 

 

4. Enter your email address and password. Click 'OK' to continue. 
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5. In the 'Available Restore Points' screen, click on the backup you wish to 
restore from the ensuing list (once selected, the backup will be highlighted in 
blue as per the above screenshot). Click 'Next' to continue. 

 

 

6. Click 'Finish' to complete the restoration process. 

Warning Messages 



Quick Start Guides 

37 

No Internet Connection 

 

Should the user’s internet connection drop out at any point whilst using the 
software, the above pop-up message will appear. 

The user can continue to use the software, and any changes will be saved 
locally. 

This message will continue to pop up regularly while the computer is 
disconnected from the internet. To suppress this message, tick the 'Do not show 
this message again for the rest of the day' check box. 

When the software detects that the internet has been restored, the data will be 
backed up to the cloud. 

Data Conflict 

 

Occasionally, the user may see the above pop-up message. This may occur if the 
user has accessed the same data on two computers, or if the user is attempting 
to restore an older version of the project than stored on the cloud. 

At this point the user must choose carefully from the following three options: 

• Take the cloud’s version – this will restore the latest version of this data 
from the cloud (and overwrite the version on your computer) 

• Upload your version – this will upload the data located on your computer 
and overwrite the data in the cloud 
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• Continue (Read Only) – this will not touch the data either on your 
computer or in the cloud. The user can use the application for viewing 
purposes in read-only mode 

 

 

Similarly, the user will see the above pop-up message if he or she has edited the 
data on their computer, and the system detects upon closing the software that a 
newer version of the data is already stored on the cloud. 

Should this occur, the user will need to choose from the following two options: 

• Upload your version – this will overwrite the data stored on the cloud with 
this version of your data 

• Cancel Cloud Backup – choosing this option will mean the changes you 
have made are retained on this computer, but they will not be saved to the 
cloud. The next time you start the software you will be offered the three 
choices detailed in the first pop-up message above. 

 

Frequently Asked Questions 

Q: Can I reset my password? 

A: Users can reset their password for free by using the Accountz Online Service 
website, accessible via the Help menu (Help>Reset Cloud Backup Password), and via this 
link. 

Q: Can two computers access the same data file at the same time? 

A: The cloud is NOT a multi-user functionality, and therefore to avoid any 
potential loss of data, users are advised not to update the same data on 
different computers simultaneously.  

 
Q: If I buy a second Accountz Cloud Backup and Recovery service can I 
use the same email address? 

A: No. Each copy of the Accountz Cloud Backup and Recovery system that you 
purchase will need a separate email address. 

http://online.accountz.co.uk/
http://online.accountz.co.uk/
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Q: What if I lose access to my email address? 

A: You are able to purchase an email re-set service from Accountz.com for a fee. 

 
Q: Can my accountant have access to my cloud backup? 

A: It is entirely up to you who you give access of your private information to and 
solely your responsibility. 

 
Q: What happens if my internet dips out and I am temporarily 
disconnected? 

A: The program will inform you if it can not connect to the cloud backup service 
but will continue to perform local backups as normal. When your internet 
connection returns then the program will perform a sync to the cloud at the next 
available opportunity. 

 
Q: Can I purchase a replacement Home Accountz Cloud key? 

A: Yes, there is a small administrative fee for this service. Please see Accountz 
Cloud Backup and Recovery Terms & Conditions 

 
Q: Will any firewall software that I use affect my being able to use 
Accountz Cloud Backup and Recovery? 

A: If you are running Accountz Cloud Backup and Recovery and you employ a 
firewall program on your computer then you will need to set up a rule to allow 
the Accountz application to contact the internet. This will prevent your firewall 
program from repeatedly asking you for permission when the Accountz 
application performs a sync. 

 
Q: How many backups are stored on the cloud? 

A: See section 1.2, here: Accountz Cloud Backup and Recovery Terms & 
Conditions 

 
Q: What will happen when my Cloud Backup Service is due to expire? 

A: Accountz will send an email a month before it’s due to expire advising you 
that the cloud backup service will expire in a month. If you wish to continue with 
the service then you can purchase a new licence on the Accountz website or via 
the telephone. 

http://www.accountz.com/pages/accountz-cloud-backup-terms-and-conditions
http://www.accountz.com/pages/accountz-cloud-backup-terms-and-conditions
http://www.accountz.com/pages/accountz-cloud-backup-terms-and-conditions
http://www.accountz.com/pages/accountz-cloud-backup-terms-and-conditions
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Q: What will happen if my Cloud Backup Service has expired? 

A. If you don’t renew the Cloud service, the software will automatically cease 
performing backups on the cloud. It will keep creating local backups. If you wish 
to re-activate the service, you can purchase a new licence key on the Accountz 
website or via the telephone. 

 
Q: How many computers can I access my Accountz Cloud Backup from? 

A: You can access your data from the Cloud on as many computers that your 
software product is licenced to. Please see the EULA: 
www.accountz.com/accountz/end-user-licence-agreement 

 
Q: I make backups on a USB memory stick/external drive, why do I need it?  

The Accountz Cloud Backup Service safeguards your data in the event of you 
losing your USB memory stick/external drive or it becoming corrupted. 

 
 
 

Further Resources 

Please see the following links: 

• Make a Backup 
• Restore a Backup 
• Cloud Backup Settings 
• Local Backup Settings 
• Cloud Troubleshooting 
• Cloud Backup Speed 

  

  

  

  

  

  

  

  

http://accountz.com/pages/eula
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How to 
How To Guides 

• Entering Your First Transactions 
• Complete Transaction Process Guide 
• Rapid Data Entry 
• Views 
• Creating and Customising Views 
• Creating and Customising Documents 
• Importing Data 
• How To Enter Opening Balances 
• Licence Key Essentials 
• UK Switching from VAT Cash Accounting To Standard VAT (accrual) 
• Accounting for Investments - Stocks and Shares 
• Client Accounts 
• Create a Report (e.g. Nominal Ledger, Bank Account) with Consolidated Brought 

Forward Balances 
• How To Create A Landscape Invoice Design 
• UK EC Acquisitions VAT Boxes 2 and 4 
• UK VAT Apportioning for Personal Use 
• UK How to change back Sales Tax Date to Tax Date 
• How to set or re-set your business (VAT) start date 
• How To Refund A Customer 
• How To Lock and Unlock Transactions 
• How to sort transactions into date order 
• Year Ends and continuing into a New Year 
• How to create New Accounts and Account Groups 
• How to format a table on an Invoice-Quote-Credit Note-Purchase Order 
• Deposit paid for by third party 
• Tax Deducted at Source 
• Factoring 
• What to do if you become VAT registered 
• UK Tax for the Self-Employed 
• UK VAT126 Claim for Refund by Local Authorities 
• UK VAT Road Fuel Scale Charge 
• UK VAT Corrections 
• How to move an account from one group to another 
• Nominal Ledger Report 
• How to account for dead stock 
• Setting a different backup path 
• How to create your own shortcuts in Business Accountz 
• UK CIS Construction Industry Scheme 
• UK Reclaiming forgotten VAT 
• Business Accountz won't start 
• How to restore your data after re-installation 
• How to print a report for transactions up to a certain date 
• Create a Template Purchase 
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• Create a Template Sale 
• Create a Template Transfer 
• How to pay yourself back/refund yourself 
• How to add a Custom Field to a template 
• How to use Multi Currency 
• How to create Remittance Advice 
• How to enter negative figures in Business Accountz 
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Business Processes 
 

Record a sale 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

A sale can be recorded in 2 places: 

1. In the Sales Transactions Component 
2. In the Customer Records Component 

 
The protocol for both is identical, with the exception that in the Sales 
Transactions component the option is there to associate the sale with a 
customer, whereas in the Customer Records component this is automatically 
assigned. 

We will describe this process in the Sales Transactions component. 

First, select the component, either by clicking on the Sales Transactions icon, or 
by choosing Sales>Sales Transactions from the main menu. 

There are five fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account, Total 
Amount, and VAT Code (provided you are Tax registered). There are further 
fields which can be filled in to embellish the transaction with extra information, 
such as Customer, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 
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Record an expense 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Expenses are recorded in the Purchase Transactions Component. 

Select the component, either by clicking on the Purchase Transactions icon, or 
by choosing Payments > Purchase Transactions from the main menu. 

There are five fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account, Total 
Amount, and VAT Code (provided you are Tax registered, note that the text here 
will vary depending on your tax regime). There are further fields which can be 
filled in to embellish the transaction with extra information, such as Supplier, 
Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 
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Record a purchase of stock for resale 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Purchases of stock for resale are recorded in the Purchase Transactions 
Component. 

Select the component, either by clicking on the Purchase Transactions icon, or 
by choosing Payments > Purchase Transactions from the main menu. 

There are five fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account, Total 
Amount, and VAT Code (provided you are Tax registered, note that the text here 
will vary depending on your tax regime). There are further fields which can be 
filled in to embellish the transaction with extra information, such as Supplier, 
Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

Turn on the Quantity column if you are purchasing more than 1 item, and also 
the unit price column too. 

If you have Business Accountz Enterprise and the Product Management, you can 
record specific details about the product itself as well as look at the product 
history (eg. how many ordered, when and for how much, how many sold, when 
and for how much, plus how many are currently left in stock). You can also use 
the Supplier records module to create purchase orders, which can subsequently 
be turned into purchase transactions when those orders are received. 
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Record a purchase of equipment for use in 
the business 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Purchases of assets such as equipment are recorded in the Purchase 
Transactions Component. 

Select the component, either by clicking on the Purchase Transactions icon, or 
by choosing Payments > Purchase Transactions from the main menu. 

There are five fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account, Total 
Amount, and VAT Code (provided you are Tax registered, note that the text here 
will vary depending on your tax regime). There are further fields which can be 
filled in to embellish the transaction with extra information, such as Supplier, 
Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

One of the default accounts is called Equipment. The From account will be the 
account being used to pay for the equipment (eg. Bank, Cash, Credit Card or 
Bills Unpaid if it is being bought on credit). The To account will be Equipment. 
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Record a purchase of raw materials for 
manufacturing 
  

Introduction 

Purchases of assets such as raw materials to be used for manufacturing are 
recorded in the Purchase Transactions Component. 

Select the component, either by clicking on the Purchase Transactions icon, or 
by choosing Payments > Purchase Transactions from the main menu. 

There are five fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account, Total 
Amount, and VAT Code (provided you are Tax registered, note that the text here 
will vary depending on your tax regime). There are further fields which can be 
filled in to embellish the transaction with extra information, such as Supplier, 
Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

One of the default accounts is called Raw Materials if you answered Yes to the 
manufacturing question in the company setup wizard. The From account will be 
the account being used to pay for the materials (eg. Bank, Cash, Credit Card or 
Bills Unpaid if it is being bought on credit). The To account will be Raw Materials. 

If the Raw Materials account is not present, go to the Chart of Accounts 
component and add to the Current Assets Group. 
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Record a receipt of money from a customer 
  

Introduction 

If you have already entered an invoice in the Sales Transactions component, and 
your customer is now paying it, enter a new transaction in the Transfer 
Transactions component. 

Select the component, either by clicking on the Transfer Transactions icon, or by 
choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Customer, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be Invoices Unpaid and the To account will be the account 
you are paying the money into (eg. Bank, Cash or Undeposited Funds if you are 
going to pay in more than 1 cheque at the same time to the bank). 

NOTE: If you have not entered the invoice and it is being paid immediately, then 
you can do it all directly in the Sales Transactions component. In this case the 
From account will be the Sales account you are using to analyse the sale and the 
To account will be the same as described above (eg. Bank). 
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Paying a bill 
  

Introduction 

If you have already recorded a bill in the Purchase Transactions component, and 
you now want to pay it, enter a new transaction in the Transfer Transactions 
component. 

Select the component, either by clicking on the Transfer Transactions icon, or by 
choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Supplier, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be the account being used to pay the bill (eg. Bank, Cash 
or Credit Card) the To account will be Bills Unpaid. 

NOTE: If you have not entered the bill and are paying it immediately, then you 
can do it all directly in the Purchase Transactions component. In this case the 
From account will be the account being used to pay the bill (eg. Bank, Cash or 
Credit Card). 
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Record a sales refund 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

A sales refund can be recorded in 2 places: 

1. In the Sales Transactions Component 
2. In the Customer Records Component 

 
The protocol for both is identical, with the exception that in the Sales 
Transactions component the option is there to associate the sale with a 
customer, whereas in the Customer Records component this is automatically 
assigned. 

We will describe this process in the Sales Transactions component. 

If you are adding a refund with no previous sales transaction (because it was 
held in some previous software, or manual bookkeeping system) then do this: 

First, select the component, either by clicking on the Sales Transactions icon, or 
by choosing Sales>Sales Transactions from the main menu. 

There are five fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account, Total 
Amount, and VAT Code (provided you are Tax registered). There are further 
fields which can be filled in to embellish the transaction with extra information, 
such as Customer, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

Enter your Sales account in the From field and the place the refund is going to in 
the To field (eg. Bank or Invoices Unpaid). Enter the Total including VAT but as a 
negative amount. Press the correct VAT code if registered and that's it done. You 
are simply reversing the original transaction by doing this (ie. using negative 
amounts). 

If you have the original sales transaction in the system it is much easier: 
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1. Find and highlight the original transaction 

2. Click the Insert Credit Note based on this sale - Inserts credit note 
transaction(s) based on the selected sale(s) 

3. Enter the date of the refund and you are done 
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Record a purchase refund 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Refunds are recorded in the Purchase Transactions Component. 

Select the component, either by clicking on the Purchase Transactions icon, or 
by choosing Payments > Purchase Transactions from the main menu. 

There are five fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account, Total 
Amount, and VAT Code (provided you are Tax registered, note that the text here 
will vary depending on your tax regime). There are further fields which can be 
filled in to embellish the transaction with extra information, such as Supplier, 
Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be the account that the refunded money is being paid into 
(eg. the Bank). The To account will be the expense or purchase account where 
this purchase was originally recorded. Enter the Total amount as a negative 
figure. Enter the relevant VAT code and you are done. By entering a negative 
amount, you are reversing the original transaction. 
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Record interest received 
  

As there is no VAT in interest received from investments or the bank, this can be 
recorded in the Transfer Transactions component. 

First, select the component, either by clicking on the Transfer Transactions icon, 
or by choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be either a dedicated Interest Received income account 
or the default Other Income account. The To account will be your bank (if it is 
bank interest you are receiving). Please see image below: 

 

It is important that you are aware this is income from interest as it will usually 
already be taxed at source, so make sure that is clear when you fill in your tax 
forms at year end. 
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Record PAYE 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Make 3 entries in Transfer Transactions. The first for the total paid to employees 
will be From Bank To Employee Wages Account, the second for the Tax and 
NIC's paid to HMRC will be From Bills Unpaid To Employee Tax/NIC Account. 

 

Then a third entry is entered when the payment is made to HMRC and is entered 
as From Bank To Bills Unpaid. 

 

 

You can make as many of the first entry as you like to cover each employee 
individually if you like, or consolidate into a single transaction per payday. 
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Paying yourself if self-employed 
Paying yourself money from your business when you are self-employed is not an 
expense of the business. This is a common mistake. If you are an employee, 
then it is. This topic is for self-employed only: 

First you will need to add an account called Drawings of type Drawings Account 
into the Chart of Accounts > Equity section. 

Whenever you pay yourself, make a new Transfer Transaction From Bank To 
Drawings. 
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Paying VAT to HMRC 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Select the component, either by clicking on the Transfer Transactions icon, or by 
choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Supplier, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be the account being used to pay HMRC (eg. Bank, Cash 
or Credit Card) the To account will be VAT Control. 
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Recording a VAT refund from HMRC 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Select the component, either by clicking on the Transfer Transactions icon, or by 
choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Supplier, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be VAT Control. The To account will be wherever HMRC 
are paying the refund to (eg. your Bank). 
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Paying Corporation Tax to HMRC 
  

Introduction 

Select the component, either by clicking on the Transfer Transactions icon, or by 
choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Supplier, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be the account being used to pay HMRC (eg. Bank, Cash 
or Credit Card) the To account will be Corporation Tax. 

If you do not have a Corporation Tax Account set up. Do this: 

1. Open the Chart of Accounts component 
2. Double-click the Equity Group > Profit and Loss Group in the left hand panel. 

This will open it in the right hand panel. 
3. Select the Sub-accounts tab at the bottom of the right panel 
4. Click the Add new account button in the toolbar in that panel 
5. Enter a name for the account (eg. Corporation Tax) and set the account type 

as Tax Account 

Note you could set up a Tax Group if you preferred and then open a Corporation 
Tax Account in that group. 
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Customers 
 

Add a new customer 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Contents 

• 1 Overview 
• 2 Add a new customer to a transaction table 
• 3 Add a customer to the Customer Records component 
• 4 Add a customer in the Customer Table component 

Overview 

There are 3 ways to add a new customer in Business Accountz: 

1. Via the Customer column in a transaction table 
2. Via the Customer Records component  
3. Via the Customer Table component  

 

Add a new customer to a transaction table 

It is possible to add a customer to any transaction table which contains the 
'Customer' column. 

First, click in the 'Customer' field of any transaction. 

 

 
Next, click 'New' from the drop down list which appears. 
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Enter the customer's name in the 'Add New Customer' field, and click 'Add' to 
finish. 

 

 
The customer's name is associated with this transaction, and added to the 
Customer Records and Customer Table component 

 

 

Add a customer to the Customer Records component 

Only available in Professional and Enterprise versions of Business Accountz 
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To create a new customer within the Customer Records 
window, click the 'Create a New Customer' button at the top of the Customer 
Details panel. 

This will clear the customer name/address fields and place the cursor in the 
'Name' field, ready for you to start typing. Enter information as required into the 
following fields: 

• Name - The Customer's Name 
• Address - The Customer's Address 
• Postcode - The Customer's Postcode 
• Country - The Customer's Country of address 
• Notes - Any further notes you may wish to add about the customer 
• Reference - Use this for any further reference details about the customer 
• VAT Number - The Customer's VAT Number 
• Account From - An account entered here will automatically be entered in 

any transaction/quotation for this customer within this component 
• Account To - An account entered here will automatically be entered in any 

transaction/quotation for this customer within this component 

 
Please note that the new customer details are automatically saved. 

Add a customer in the Customer Table component 
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Only available in Basic, Professional, and Enterprise versions of Business 
Accountz 

 

 

 

Click the 'Add a New Customer' button in the toolbar at the top of the 
Customer Table window. 

This will add a new line to the table. Enter your customer's details as required. 

Please note: the new customer data is automatically saved. 
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Add a contact 
  

To add a new contact to a customer open the Customer Records component by 

clicking on the button or selecting Sales > Customer Records 
from the main menu. 

1. Find the customer you wish to add the contact to 
2. Select the Contact Details Tab 

3. Click the button 
4. Enter the new contact details 

You can add as many contacts as you like to each customer and add details to 
each contact such as position, telephone, email etc. 

To add a contact to a Supplier, the process is as above, except you will need to 
open the Supplier Records component (Payments>Supplier Records, or by 
clicking the Supplier Records icon in the main toolbar). 

  

You can also attach documents or folders to each contact. Four per contact by 
dragging them onto the empty Link fields. Once attached, click the associated 
Link buttons on the right to view the documents or folder contents. This is useful 
for attaching letters you may have written. 

If you have a lot of correspondence with a contact, keep those letters in a folder 
and drag the folder on the link. That way you can associate hundreds of 
documents with a single contact. 
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Remove a customer 
Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

 

To remove a customer open the Customer Records component by clicking on the 

button or selecting Sales > Customer Records from the main 
menu. 

1. Find the customer you wish to remove 
2. Select the Customer Details Tab 
3. Tick the Deleted checkbox  

 



Customers 

77 

 
 

Design an Invoice-Quote-Credit Note 
Template 
  

Contents 

• 1 Introduction 
• 2 Create a complete set of document templates 
• 3 Create or Edit individual document templates 
• 4 Using your new templates 

Introduction 
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Whenever you create an invoice, quote or credit note, your document is created 
within the Document Editor component. 

The design of the document, as detailed in the Preview Tab, is based on a pre-
existing document template (as selected from the Template picker drop down 
menu - for example, in the screenshot above the template selected is entitled 
'Default A4 Portrait'). 

The Accountz Designer enables you to create or edit document templates to suit 
your business needs. There are a number of ways to achieve this. 

 

Create a complete set of document templates 

 

 
The Template Builder component (Documents>Template Builder) enables the 
user to create a complete set of document templates rather than having to 
create each type of document template separately (i.e. Invoice / Credit Note / 
Quote / Purchase Order). Click here for more information. 

 

Create or Edit individual document templates 
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Users can also use the Template Editor component to create or edit individual 
document templates. 

This is managed by clicking the Copy button for the selected template within the 
Templates screen (this creates a new template based on the one selected), or 

clicking the Edit button to edit individual templates (this option is also 
available in the Preview tab of the Document Editor). 

Click here for more information. 

 

Using your new templates 
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Once complete, the new template(s) are visible within the Templates screen, 
and are immediately available for selection from the Template picker within the 
Document Editor component (see screenshot). 
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Produce an invoice 
Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

1. Open the Customer Records component. 
2. Find the customer you wish to invoice (use the selector on the left of the 

panel, or click on the Customer drop down menu at the top of the page). 

3. Click on the Create a New Invoice button  

 

 

 
This opens the Document Editor component. Add your new transactions, then 
click the Preview Tab at the top to view the invoice and either generate it as a 
PDF file, or print/email/save it. 
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Produce a quotation 
Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

1. Open the Customer Records component. 
2. Find the customer you wish to send a quotation to (use the selector on the 

left of the panel, or click on the Customer drop down menu at the top of the 
page). 

3. Click on the Create a New Quotation button  

 

 

 
This opens the Document Editor component. Add your new transactions, then 
click the Preview Tab at the top to view the quotation and either generate it as a 
PDF file, or print/email/save it. 
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Produce a credit note 
Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

1. Open the Customer Records component. 
2. Find the customer you wish to issue a Credit Note to (use the selector on the 

left of the panel, or click on the Customer drop down menu at the top of the 
page). 

3. Click on the Create a New Credit Note button  

 

 

 
This opens the Document Editor component. Add your new transactions, then 
click the Preview Tab at the top to view the credit note and either generate it as 
a PDF file, or print/email/save it. 
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Record a receipt of money from a customer 
  

Introduction 

If you have already entered an invoice in the Sales Transactions component, and 
your customer is now paying it, enter a new transaction in the Transfer 
Transactions component. 

Select the component, either by clicking on the Transfer Transactions icon, or by 
choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Customer, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be Invoices Unpaid and the To account will be the account 
you are paying the money into (eg. Bank, Cash or Undeposited Funds if you are 
going to pay in more than 1 cheque at the same time to the bank). 

NOTE: If you have not entered the invoice and it is being paid immediately, then 
you can do it all directly in the Sales Transactions component. In this case the 
From account will be the Sales account you are using to analyse the sale and the 
To account will be the same as described above (eg. Bank). 
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Setup or edit incrementing invoice, quote, 
credit note and purchase order numbers 
Please note that this process is also covered by the Easy Steps Button, available 
to Business Accountz V3 & 2012 users. 

To set your invoice/credit note/quotation/purchase order number select the 
Templates component via the main menu option: Documents > Templates. 
Select the relevant document type from the four Sales Documents options in the 
left column (i.e. Invoices, Quote, Credit Note, Purchase Order) and click the 
'Change' button in the top middle of the screen. 

 

 

It is named 'Document' number rather than 'Invoice' etc. as there are many 
different document types and all have the ability to automatically increment 
numbers. 

Next time you open a new invoice the 'Last Document Number' will be auto-
incremented and added to the invoice reference field. You can edit or over-ride 
that number if necessary. 
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Purchases 
 

Add a supplier 
Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

Contents 

• 1 Overview 
• 2 Add a new supplier to a transaction table 
• 3 Add a supplier to the Supplier Records component 
• 4 Add a supplier in the Supplier Table component 

Overview 

There are 3 ways to add a new supplier in Business Accountz: 

1. Via the Supplier column in a transaction table 
2. Via the Supplier Records component  
3. Via the Supplier Table component  

 

Add a new supplier to a transaction table 

It is possible to add a supplier to any transaction table which contains the 
'Supplier' column. 

First, click in the 'Supplier' field of any transaction. 

 

 
Next, click 'New' from the drop down list which appears. 
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Enter the supplier's name in the 'Add New Supplier' field, and click 'Done' to 
finish. 

 

 
The supplier's name is associated with this transaction, and added to the 
Supplier Records and Supplier Table component 

 

 

Add a supplier to the Supplier Records component 

Only available in the Enterprise version of Business Accountz 
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To create a new supplier within the Supplier Records 
window, click the 'Create a New Supplier' button at the top of the panel. 

This will clear the supplier name/address fields and place the cursor in the 
'Name' field, ready for you to start typing. Enter information as required into the 
following fields: 

• Name - The Supplier's Name 
• Address - The Supplier's Address 
• Postcode - The Supplier's Postcode 
• Country - The Supplier's Country of address 
• Notes - Any further notes you may wish to add about the supplier 
• Reference - Use this for any further reference details about the supplier 
• VAT Number - The Supplier's VAT Number 
• Account From - An account entered here will automatically be entered in 

any transaction/quotation for this supplier within this component 
• Account To - An account entered here will automatically be entered in any 

transaction/quotation for this supplier within this component 

 

Please note that the new supplier details are automatically saved. 

Add a supplier in the Supplier Table component 

Only available in Basic, Professional, and Enterprise versions of Business 
Accountz 
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Click the 'Add a New Supplier' button in the toolbar at the top of the 
Supplier Table window. 

This will add a new line to the table. Enter your supplier's details as required. 

Please note: the new supplier data is automatically saved. 
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Add a contact 
  

To add a new contact to a customer open the Customer Records component by 

clicking on the button or selecting Sales > Customer Records 
from the main menu. 

1. Find the customer you wish to add the contact to 
2. Select the Contact Details Tab 

3. Click the button 
4. Enter the new contact details 

You can add as many contacts as you like to each customer and add details to 
each contact such as position, telephone, email etc. 

To add a contact to a Supplier, the process is as above, except you will need to 
open the Supplier Records component (Payments>Supplier Records, or by 
clicking the Supplier Records icon in the main toolbar). 

  

You can also attach documents or folders to each contact. Four per contact by 
dragging them onto the empty Link fields. Once attached, click the associated 
Link buttons on the right to view the documents or folder contents. This is useful 
for attaching letters you may have written. 

If you have a lot of correspondence with a contact, keep those letters in a folder 
and drag the folder on the link. That way you can associate hundreds of 
documents with a single contact. 
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Remove a supplier 
Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

 

To remove a supplier open the Supplier Records component by clicking on the 

button or selecting Payments > Supplier Records from the main 
menu. 

1. Find the supplier you wish to remove 
2. Select the Supplier Details Tab 
3. Tick the Deleted checkbox  
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Design a purchase order 
  

Designing a Purchase Order is much the same when designing an invoice or any 
other document. Full details can be found in the Design an invoice/quote/credit 
note help file. 
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Paying a bill 
  

Introduction 

If you have already recorded a bill in the Purchase Transactions component, and 
you now want to pay it, enter a new transaction in the Transfer Transactions 
component. 

Select the component, either by clicking on the Transfer Transactions icon, or by 
choosing General > Transfer Transactions from the main menu. 

There are four fields which MUST be completed for the transaction itself to be 
considered complete by the software: Tax Date, From Account, To Account and 
Total Amount. There are further fields which can be filled in to embellish the 
transaction with extra information, such as Supplier, Reference. 

Next, click the Create a new transaction button in the top toolbar. This 
adds a new transaction line to the table. 

Enter the date in the Tax Date field. As you start typing, a pop-up calendar will 
appear. You can either click on the required date, or type it in manually. The 
software will recognise most date dividers, such as full stops, slashes, etc. 

The From account will be the account being used to pay the bill (eg. Bank, Cash 
or Credit Card) the To account will be Bills Unpaid. 

NOTE: If you have not entered the bill and are paying it immediately, then you 
can do it all directly in the Purchase Transactions component. In this case the 
From account will be the account being used to pay the bill (eg. Bank, Cash or 
Credit Card). 
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Setup or edit incrementing invoice, quote, 
credit note and purchase order numbers 
Please note that this process is also covered by the Easy Steps Button, available 
to Business Accountz V3 & 2012 users. 

To set your invoice/credit note/quotation/purchase order number select the 
Templates component via the main menu option: Documents > Templates. 
Select the relevant document type from the four Sales Documents options in the 
left column (i.e. Invoices, Quote, Credit Note, Purchase Order) and click the 
'Change' button in the top middle of the screen. 

 

 

It is named 'Document' number rather than 'Invoice' etc. as there are many 
different document types and all have the ability to automatically increment 
numbers. 

Next time you open a new invoice the 'Last Document Number' will be auto-
incremented and added to the invoice reference field. You can edit or over-ride 
that number if necessary. 

  

  

  

  

  



Purchases 

99 

  

  

  

  

 



 

100 

VAT 
 

Complete a VAT return (Standard VAT) 
  

Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

You can view any VAT return at any time by clicking on the main menu option 
VAT Return > VAT Return or the main toolbar VAT Return button. 

Full instructions on the VAT return itself can be found here: VAT Return 
Component 

When you have finished a VAT period (usually 3 months) you will need to do one 
of the following: 

1. Pay the VAT to HMRC 
2. Record a refund from HMRC 
3. No VAT to be refunded or paid 

In the latter case, you need to do nothing at all. Box 5 of the VAT Return for the 
period will be zero. 

For cases 1 or 2 go to the Transfer Transactions component and enter a new 
transaction. 

The From account will be your bank (or other money source that is paying it). 
The To account will be VAT Control. 

 

If you are being refunded reverse the accounts (From VAT Control To Bank) 
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Complete a VAT return (Flat Rate Scheme) 
  

Whenever you make a sales or purchase transaction and you are on the VAT Flat 
Rate Scheme, always use the 0% VAT Flat Rate code. All amounts must be 
entered including the full VAT. 

At the end of each VAT period (normally 3 months) you will need to add 2 
transactions to complete the period. 

1. A sales transaction to account for your rate of Flat Rate VAT 
2. Another transaction to adjust your profit and loss account and adjust box 6 of 

your VAT return 

The following screenshot shows 3 typical sales transactions, then the 2 
adjustments described above. Note that no matter how many sales transactions 
you may have for the period, you will only ever need to add the 2 adjustment 
transactions described above. 

 

The first 3 normal sales transactions total £1,000. The flat rate set for this 
example is 10%. So the VAT owed is £100. Transaction 4 (dated 31/12/2013) 
shows the £100 being recorded as 100% VAT. It does not affect the From 
account at all. Transaction 5 (also dated the 31/12/2013) is the second 
transaction needed to adjust the profit and loss account by removing the VAT 
element from it. It also ensures the correct amount is included in box 6 of the 
VAT Return. 

Here is a screenshot of the Chart of Accounts after both period ending 
transactions have been entered. Sales are correct at £900 and the VAT Control is 
also correct at £100. 
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And finally, here is the VAT Return itself for this period. Box 5 shows the £100 
VAT liability and Box 6 shows the correct ex-VAT output tax for the period. You 
can also see all the Sales output tax transactions including the 2 adjustments for 
the period. 
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Online VAT Submission 
  

Contents 

• 1 Introduction 
• 2 Submitting A VAT Return 
• 3 Submit VAT Return On-line Wizard  

o 3.1 Setup Information 
o 3.2 Sending 
o 3.3 Success 

Introduction 

If you pay your VAT in the UK to HMRC via their online gateway you can submit 
your VAT returns directly from Business Accountz using this component. 

Submitting A VAT Return 

To submit a VAT return using Business Accountz you need to go to the VAT 
Return component. 

Ensure that you have the period you wish to submit selected in the 

VAT_Period_Selector drop down box  

In the tool bar of the VAT Return component you will see the following two 
buttons: 

1. Submit VAT Return On-line Wizard 

2. VAT Submission History 

Click the Submit VAT Return On-line button to start the on-line 
submission wizard. 

Submit VAT Return On-line Wizard 

Setup Information 
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The first time you perform an on-line submission you must fill in the following 
fields: these values will be remembered for future use 

• Sender ID - To submit VAT returns on-line to HMRC you must first be 
registered with them. Once you have registered with their on-line gateway 
service you will be provided with a "Sender ID" that you must enter into this 
field. 

• VAT Registration Number - Enter your company's VAT registration number 
into this field 

• Lock Transactions Involved - If this check box is ticked then once a 
submission has been successfully made the application will either: 

a) set the transaction lock date to be equal to the end of the VAT period just 
submitted if you use accural accounting, or 
b) if you use cash based accounting the application lock all transactions used 
to calculate the VAT return for the selected period 

Once you are ready click the "Submit" button to start sending your VAT return. 

Sending 
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While Business Accountz is sending your VAT return to HMRC you will see this 
dialogue box. 

It may take a minute or so to receive a response from the HMRC servers so 
please be patient. 

Success 

 

If your VAT submission is accepted by HMRC you will see the dialogue similar to 
the one above 

Clicking the "View Submission History" button will take you to the Online VAT 
Submission History screen where you can review the submission you have just 
made including: 

• The amount due for payment 
• The due date 
• The date the payment will be taken if you have a Direct Debit set-up 
• Any additional messages received from HMRC 
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Business Accountz V3 Help 

108 

 
 

Online VAT Submission History 

Contents 

• 1 Introduction 
• 2 Screen Layout  

o 2.1 Past Submissions 
o 2.2 Selected Submission Messages 
o 2.3 VAT Totals for selected submission 
o 2.4 Export Digital Receipt 

Introduction 

The 'Online VAT Submission History' screen shows you all successful on-line VAT 
submissions you have made using Business Accountz. 

This screen allows you to see all the related information about a VAT submission 
including: 

• The amount due for payment 
• The due date 
• The date the payment will be taken if you have a Direct Debit set-up 
• Any additional messages received from HMRC 

Screen Layout 

 

 

Past Submissions 
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This table list all the successful on-line VAT submission made using Business 
Accountz in chronological order. There are six columns: 

• Date Submitted-The date the submission was made 
• For VAT Period-The start and end date of the VAT period submitted 
• Amount Due-The total amount owed to HMRC for the period 
• Payment Due-The due date for the payment 
• Collection Date-The date the amount due will be taken if you have a Direct 

Debit set-up with HMRC for that period 
• Paid- A user controlled flag that lets you record if you have made the 

payment to HMRC for the given period. 

Selected Submission Messages 

This text area displays any messages that were received from HMRC for the 
period currently selected in the Past Submissions table 

VAT Totals for selected submission 

This table shows you the calculated figures that were submitted to HMRC for the 
period currently selected in the Past Submissions table 

Export Digital Receipt 

This button allows you to download the HMRC digital receipt received for the 
period currently selected in the Past Submissions table. You may want to store 
these receipts somewhere for your future records. 
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EC Sales List 
  

If you are VAT registered and export to other EC (European Community) 
countries you will need to fill in an EC Sales list. You can get a list by using the 
EC Sales View from the drop down menu in Sales Transactions. 

 

Either export that report or create yourself a new View based on this one and 
add conditions to restrict the date range. At the moment there is no way of 
showing each customer's VAT number against a sale, which you will need for the 
report, so it is best to copy and paste that into the Notes column when you enter 
export transactions. 

On the EC Sales List there is a column on the right called 'Indicator'. Here are 
the values and meanings: 

0 = Goods 

2 = Intermediate supplier in a triangulated sales (full details can be found on the 
HMRC site, here:  http://www.hmrc.gov.uk/vat/managing/international/esl/ ) 

3 = Services 

Note: VAT rules do change. Please always check with HMRC about Tax and VAT 
issues. 

  

  

  

  

http://www.hmrc.gov.uk/vat/managing/international/esl/
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Handling part payments with VAT Cash 
Accounting Scheme 
  

If you are on the UK VAT Cash Accounting Scheme (whereby you only account 
for VAT when invoices and purchases are actually paid for) then you will need to 
follow this procedure. 

You will need to split the original invoice or receipt into multiple transactions. 

Example Original transaction for 120.00 including VAT 

 

An amount of 60 is paid towards this. The original invoice is split into 2 
transactions. If the customer does not pay off the second part in full, then it will 
need splitting again into a third transaction. 
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Miscellaneous 
Bank Reconciliation 
You can reconcile your bank/credit card in Business Accountz via the Chart of 
Accounts component. 

Please follow these steps: 

1. Make sure you have a copy of your paper/online bank statement to hand. 

  

 

2. Select the Chart of Accounts component from the top tool bar. 

3. Double click on your bank account in the left hand accounts tree - this will 
open a tab in the right panel displaying the account's transactions. 
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4. Select the 'Uncleared Entries' view from the 'Viewing' drop down list. This will 
display only transactions which have yet to be marked as cleared from your 
account. 

5. For every entry in the software that matches its equivalent in your paper 
statement, tick the 'Cleared' box to mark the transaction as cleared. 

6. Once you have done this for every matching transaction, your Statement 
Balance in the left hand chart of accounts tree should match the balance 
displayed on your physical statement. 

  

Troubleshooting 
If the statement balances do not match as per point 6 (above), this can usually 
be attributed to the following: 

1. First, double check that all matching entries have definitely been marked as 
cleared. 

2. It may be that you have forgotten to enter a transaction into the software 
which subsequently is visible on your physical balance. Try subtracting the 
software's statement balance from the physical statement balance - the result 
can sometimes match the value of an overlooked, yet-to-be-entered transaction. 
If this is the case, enter the transaction as per the statement, and mark it 
cleared. 
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3. Within the 'Uncleared Entries' tab, occasionally you may see older 
transactions which predate the physical statement being reconciled against. 
Check these against your older physical statements to make sure that they 
haven't been overlooked, and should in fact be marked as cleared. 
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Recording a Split transaction 
If you want to split a single transaction across multiple expense (or other) 
accounts here's what you do: 

1. Create a new account called 'Split Control' or something like that. Its type 
should be Cash. Create it in the Current Assets section where your other cash 
and bank accounts are. See Chart of Accounts for full details of creating 
accounts. 

Example: pay 100 by bank debit card and split it 75 to fuel, 25 to cash. 

2. Make a Transfer Transaction From Bank To Split for 100. You can now 
reconcile your bank with ease with the single amount when the next statement 
arrives. 
3. Make a Purchase Transaction From Split To Fuel for 75 
4. Make a Transfer Transaction From Split To Cash for 25 

You can of course split it across as many accounts as you need. When the 
transaction is complete the Split account will return to zero, and that is how you 
know you have split all of it correctly. Wonderfully simple, logical and 
transparent. 

If there is VAT involved in any of the Purchase Transaction splits, apply to each 
individual transaction, but make sure the overall VAT is not more than on your 
receipt. You may need to edit one of the transaction's VAT by a 1p or 2 to 
achieve this. 
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Reviewing all debtors and creditors 
Please note that this process is also covered by the Easy Steps component, 
available to Business Accountz V3 & 2012 users. 

For Debtors (aka Accounts Receivable) open the Sales Transactions component. 

1. Select the Unpaid View from the drop down menu 
2. Click on the Tax Date to sort it by date 

 

For Creditors (aka Accounts Payable) open the Purchase Transactions 
component. 

1. Select the Unpaid View from the drop down menu 
2. Click on the Tax Date to sort it by date 
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A Management Reports module is also available that includes a set of useful 
management reports including preset Debtor and Creditor reports and year on 
year and year to date figures. 
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Handling part payments 
  

If you issue an invoice and your customer only sends you part of the amount 
due this is what you need to do: 

1. Enter the original Sales Transaction as normal, but make sure the Paid 
column remains unticked. 

2. When you receive the part payment, enter it into Transfer Transactions using 
the Customer field to tie the part payment to that customer. Do the same if 
you receive any more part payments too. Make sure the 'Payment Completed' 
field remains unticked for all part payments UNTIL the invoice is paid for in 
full. 

 

If you have Business Accountz Professional or Enterprise you can use the 
Statement tab in Customer Records to send the customer a full statement. 
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When the invoice is finally settled, tick the invoice's Paid field, then tick all the 
part payments 'Payment Completed' tick boxes. This stops all these transactions 
being included on the customer statement. 
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Application Reference Guide 
Application Reference Guide 
Main Components 

• Easy Steps 
• Chart Of Accounts 
• Customer Records  
• Customer Table 
• Journal Transactions 
• Nominal Ledger 
• Product Management  
• Purchase Order Transactions  
• Purchase Transactions 
• Quotations  
• Sales Transactions 
• Supplier Records  
• Supplier Table 
• Templates 
• Transfer Transactions 
• VAT Return 

Sub Components 

• Automated Purchases  
• Automated Sales  
• Automated Transfers  
• Calculator 
• Change Company 
• Check for Upgrade 
• Cloud Backup Settings 
• Configuration 
• Convert Old Template 
• Custom Fields 
• Desk Diary  
• Document Editor 
• Error Reporting 
• Importing Data 
• Language Selection 
• Local Backup Settings 
• Make a Backup 
• Reset Templates 
• Restore a Backup 
• Set Licence Wizard 
• Show Sales Documents  
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• Show Quote Documents  
• Show Purchase Order Documents  
• Standard Reports 
• Templates Builder 
• Template Editor 
• Template Purchase  
• Template Sales  
• Template Transfers  
• VAT Configuration 
• VAT Setup 
• Year Closing 
• Your Business 

Add On Components 

• Accountz Cloud Backup and Recovery  
• Budgeting & Forecasting   
• Management Reports   
• Multi Currency  
• Payroll  
• Cost Centres   

 

Other Links 

• Reference 
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